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Preface

The Sun Blade 1500 Getting Started Guide (816-7565-11) describes how to set up the
operating environment and use the preinstalled software applications. This book is
written for users who have experience installing workstation hardware and
software.

Note – The Sun Blade 1500 Getting Started Guide is translated into French, German,
Italian, Spanish, Swedish, Japanese, Korean, Simplified Chinese, and Traditional
Chinese. The translated documentation is located on the Sun Blade 1500 Hardware
Documentation CD (705-1078). The Sun Blade 1500 Getting Started Guide and its
translations are also located at:
http://www.sun.com/documentation/

How This Book is Organized
The document is organized into chapters as follows:

Chapter 1 describes unpacking, cabling, and powering on the workstation.

Chapter 2 describes setup and use of the preinstalled Solaris™ operating
environment.

Chapter 3 describes how to start the workstation’s preinstalled software
applications.

Chapter 4 describes workstation troubleshooting.
xi
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Using UNIX Commands
The Sun Blade 1500 Getting Started Guide might not contain all of the information
needed to perform basic UNIX® commands and procedures such as shutting down
the system, booting the system, and configuring devices.

See one or more of the following for additional UNIX commands:

� Solaris Handbook for Sun Peripherals
� Sun Blade 1500 Service, Diagnostics, and Troubleshooting Manual, 816-7564
� Other Software documentation that you received with your system
� Solaris™ operating environment documentation, which is at

http://docs.sun.com

Typographic Conventions

Typeface* Meaning Examples

AaBbCc123 The names of commands, files,
and directories; on-screen
computer output

Edit your.login file.
Use ls -a to list all files.
% You have mail.

AaBbCc123 What you type, when contrasted
with on-screen computer output

% su

Password:

AaBbCc123 Book titles, new words or terms,
words to be emphasized.
Replace command-line variables
with real names or values.

Read Chapter 6 in the User’s Guide.
These are called class options.
You must be superuser to do replace
command-line variables.
To delete a file, type rm filename.

*The settings on your browser might differ from these settings.
xii Sun Blade 1500 Getting Started Guide • April 2004
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Shell Prompts

Related Documentation

Shell Prompt

C shell machine-name%

C shell superuser machine-name#

Bourne shell and Korn shell $

Bourne shell and Korn shell superuser #

Application Title Part Number

System setup Sun Blade 1500 Start Here 816-7561

Basic troubleshooting Sun Blade 1500 Troubleshooting Card 816-7563

Detailed service, diagnostics,
and troubleshooting

Sun Blade 1500 Service, Diagnostics, and Troubleshooting
Manual

816-7564

Changes to hardware,
software and documentation

Sun Blade 1500 Product Notes 816-7569

Safety and compliance Sun Blade 1500 Safety and Compliance Guide
Important Safety Information for Sun Hardware Systems

816-7566
816-7190

Solaris operating environment Solaris 8 HW 2/04 Sun Hardware Platform Guide
Solaris Handbook for Sun Peripherals
Solaris 9 4/04 Release Notes Supplement for Sun Hardware
Solaris 9 4/04 Sun Hardware Platform Guide

(Subject to
change)

Graphics accelerators Sun XVR-100 Graphics Accelerator Installation Guide
Sun XVR-500 Graphics Accelerator Installation Guide
Sun XVR-600 Graphics Accelerator Installation and User’s
Guide

816-7560
816-3028
817-2195

Co-processor board SunPCi™ III 3.2 User’s Guide 817-3630
Preface xiii



Accessing Sun Documentation Online
You can view, print, or purchase a broad selection of Sun documentation, including
localized versions, at:

http://www.sun.com/documentation/

Third-Party Web Sites
Sun is not responsible for the availability of third-party web sites mentioned in this
document. Sun does not endorse and is not responsible or liable for any content,
advertising, products, or other materials that are available on or through such sites
or resources. Sun will not be responsible or liable for any actual or alleged damage
or loss caused by or in connection with the use of or reliance on any such content,
goods, or services that are available on or through such sites or resources.

Contacting Sun Technical Support
If you have technical questions about this product that are not answered in this
document, go to:

http://www.sun.com/service/contacting/

Sun Welcomes Your Comments
Sun is interested in improving its documentation and welcomes your comments and
suggestions. You can submit your comments by going to:

http://www.sun.com/hwdocs/feedback/

Please include the title and part number of your document with your feedback. The
part number of this Sun Blade 1500 Getting Started Guide is 816-7565-11.
xiv Sun Blade 1500 Getting Started Guide • April 2004
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CHAPTER 1

Setting Up the Sun Blade 1500
Workstation

This chapter includes information about the following topics:

� Safety and Compliance Information
� Planning the Installation Process
� Unpacking the Workstation
� Cabling the Workstation
� Powering On the Workstation
� Powering Off the Workstation

Safety and Compliance Information
Read the document, Important Safety Information for Sun Hardware Systems, 816-7190.
The document is included with the Sun Blade 1500 workstation.

More safety and compliance information can be found in the Sun Blade 1500 Safety
and Compliance Guide, 816-7566. This guide is available online at:

http://www.sun.com/documentation/

Planning the Installation Process
Use the following flowchart as a process tool to assist you with installation of the
Sun Blade 1500 workstation.
1
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FIGURE 1-1 Process for Installing the Sun Blade 1500 Workstation

Note – Solaris 8 HW 2/04 or Solaris 9 4/04 and several additional software
applications are preinstalled on your hard drive. See “Setting Up the Preinstalled
Solaris Operating Environment Software” on page 9.

Unpack the workstation and familiarize yourself
with the workstation features.

Connect the workstation and external device
cables.

Power on the workstation.

Choose the Solaris version.
Answer the Solaris software prompts.

READY TO WORK!

START

Install different
version from
other media.

No

Yes

See “Unpacking the Workstation”.
See also “Front Panel Overview” and “Back Panel Overview”.

See “Cabling the Workstation”.

See “Powering On the Workstation”.

For instructions, refer to the documentation in the
Solaris Media Kit for your operating environment.

See “Setting Up Your Operating Environment”.

See “Getting Started With the Additional Preinstalled
Software”.

Use a
preinstalled
version of
software?

Install optional
components?

Install
optional
components.

Yes

No

To install DIMMs, graphic accelerators,
PCI cards, hard drives, diskette drives, tape drives, or
DVD-ROM drives, see the Sun Blade 1500 Service,
Diagnostics, and Troubleshooting Manual (816-7564)
or the documents that ship with the components.
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Unpacking the Workstation
Carefully unpack all workstation components from the packing cartons. Your
workstation configuration might not contain all the components shown in
FIGURE 1-2.

FIGURE 1-2 Unpacking the Workstation
Chapter 1 Setting Up the Sun Blade 1500 Workstation 3



Front Panel Overview

FIGURE 1-3 Front Panel Overview

Power button

Smart card reader

DVD-ROM drive

USB-1.1
Microphone

Headphone
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Back Panel Overview

FIGURE 1-4 Back Panel Overview

PCI slot 0

PCI slot 4

PCI slot 3

PCI slot 2

PCI slot 1

Universal serial bus (2)

Serial1 DB-9 (RS-232)

Twisted-pair Ethernet (TPE0)

Parallel (DB-25)

Audio output

Audio input

USB-2.x (3) IEEE 1394A (2)

(USB 1.1)

33 MHz/64-bit

66 MHz/64-bit

33 MHz/32-bit

Optional graphics
Serial0 DB-9 (RS-232)

Stereo DIN7

Connect the mouse
and keyboard to
USB 1.1 connectors only

Video

XVR-500 (66 MHz)

IEEE 1394 and USB 2.x card

accelerators

Power

(33 MHz)

XVR-100 (33 MHz)

Video DVI-I Stereo DIN7

XVR-600 (66 MHz)

Stereo DIN7 DVI-I
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Cabling the Workstation
FIGURE 1-5 illustrates the cable connections for the workstation.

FIGURE 1-5 Cabling Illustration

Connect the workstation and external devices in this order (FIGURE 1-5):

1. Connect the workstation power cord to a grounded electrical outlet.

2. Connect the keyboard and mouse to the on-board USB 1.1 connectors (the
connectors near the fan (FIGURE 1-4).

~
~
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Note – The on-board connectors are USB 1.1. You must connect the mouse and
keyboard to the USB 1.1 connectors, not the USB 2.x connectors. The IEEE 1394 and
USB 2.x card connectors are more appropriate for devices that require faster data
transfer.

3. Connect the monitor power cord to a grounded electrical outlet.

4. Connect the monitor cable to the video connector on the filler panel of the
graphics accelerator.

Note – Your Sun Blade 1500 system might contain a different graphics accelerator
than the one shown in FIGURE 1-5. Read the Sun Blade 1500 Product Notes, 816-7569, to
determine if your graphics accelerator must be installed in a specific PCI slot.

Note – Monitors that have 13W3 connectors require a Sun 13W3-to-VGA adapter
cable for proper connection. This adapter cable (Sun store part no. X471A) can be
obtained from your Sun sales representative or the Sun store at:
http://store.sun.com/
To find the cable, search for both the part number and cable description.

5. Connect the Ethernet cable to the TPE connector.

6. Connect any additional external devices to the workstation’s other connectors.

Note – The IEEE 1394 and USB 2.x card also has two internal USB 2.x connectors
and one internal IEEE 1394 connector. These three connectors are only accessible
from inside the workstation chassis.

Powering On the Workstation

Tip – If you are installing optional internal components such as additional memory
DIMMs, PCI cards, optical drives, or hard drives, see the Sun Blade 1500 Service,
Diagnostics, and Troubleshooting Manual (816-7564), or the installation document that
was provided with the components, before you power on the workstation. If you are
not installing optional components, you are ready to power on the workstation.
Chapter 1 Setting Up the Sun Blade 1500 Workstation 7
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Tip – ShowMe™ How video animations are located on the Sun Blade 1500 Hardware
Documentation CD (705-1078). These video animations demonstrate installation and
removal procedures for DIMMs, PCI cards, hard drives, and digital media drives.

1. Turn on power to the monitor and to all external devices.

2. Press and release the workstation Power button on the front panel (FIGURE 1-3).

3. After several seconds, verify that the power-indicator LED on the Power button
lights.

The power-indicator LED on the Power button lights after the workstation begins
the internal booting process (FIGURE 1-3).

If you experience problems during power on, see “Troubleshooting the Sun Blade
1500 Workstation” on page 33.

Tip – After you power on the workstation for the first time, you are ready to set up
the preinstalled Solaris 8 HW 2/04 or Solaris 9 4/04 operating environment
software. Go to “Planning the Installation Process for Solaris” on page 9.

Powering Off the Workstation
TABLE 1-1 describes two methods for powering off the workstation.

Note – After powering off the workstation, always wait at least four seconds before
powering on the workstation again.

TABLE 1-1 Powering Off the Workstation

Method Instructions

Method 1 1. Close and save any open applications.
2. Press the Sleep key (or press and release the Power button).
3. Select Shutdown.

Method 2 1. Close and save any open applications.
2. As superuser, type: shutdown
8 Sun Blade 1500 Getting Started Guide • April 2004



CHAPTER 2

Setting Up the Preinstalled Solaris
Operating Environment Software

This chapter includes information about the following topics:

� Planning the Installation Process for Solaris

� Setting Up Your Operating Environment

� Power Management Features

Planning the Installation Process for
Solaris

Your workstation has a dual-boot image. During the system set-up you can choose
either the Solaris 8 or Solaris 9 operating environment. You can only choose one
Solaris operating environment. After you choose an operating environment, the
system automatically erases the other Solaris operating environment.

Note – The Solaris operating environment version that you select requires no
licensing fee. If you install a different version of Solaris software, you may be
required to pay a license fee for the new software version.
For more information, refer to the following web site:
http://wwws.sun.com/software/solaris/licensing/index.html
9
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The exact configuration that has been preinstalled is as follows:

� Hard drive root partition—14.0 Gbytes
� Hard drive swap partition—0.5 Gbytes
� Hard drive space partition—the remainder of the primary hard drive

Note – The Sun Blade 1500 workstation requires Solaris 8 HW 2/04 or Solaris 9
4/04, or a subsequent compatible version of Solaris software.

Use the following flow chart to assist with setting up your operating environment.

FIGURE 2-1 Installation Process Flow Diagram

Setting Up Your Operating Environment
1. Power on the workstation.

See “Powering On the Workstation” on page 7.

Power on the workstation.

Choose the Solaris version. Accept the li-
cense. Answer Solaris software prompts using
information specific to your site that your sys-
tem administrator provides. If necessary, refer
to “Information for Setting Up the Solaris Desk-
top Operating Environment”.

READY TO WORK!

START

Yes

“Powering On the Workstation”.

For instructions, refer to the documentation in
the Solaris Media Kit for your operating
environment.

“Setting Up Your Operating Environment”.

See “Getting Started With the Additional Preinstalled Soft-
ware”.

No
Install different
version from
other media.

Use a
preinstalled
version of
software?
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2. Verify the version of software installed. Alternatively, you can install a newer
version of the Solaris operating environment software.

Note – Some Solaris versions might not work on the Sun Blade 1500 system. Verify
Solaris operating environment compatibility before you begin the installation.

3. Answer the Solaris operating environment setup prompts by following the on-
screen instructions.

Tip – To help answer the setup prompts, your system administrator (SA) should
provide you with information specific to your site before you begin. Some of the
information might be available on your network—check with your SA. Use a copy of
TABLE 2-1 to write down the information that you might need to collect before setting
up the Solaris operating environment.

TABLE 2-1 Information for Setting Up the Solaris Desktop Operating Environment

Setup Window Explanation and Notes Your Information

Select Language
and Locale

Native language and locale to use for the workstation.

Host Name A name to give the workstation.

Network
Connectivity

(IP Address)

Network or stand-alone workstation protocols. A system
administrator might be required to complete this section.

Note: Depending on how you answer and what
information is provided by your network, you might also
be prompted for the workstation’s IP address.

Security Settings Security settings and protocols.

Name Service Name service to use: NIS+, NIS, DNS, LDAP, or None.
Note: This window is not displayed if the workstation is
not connected to a network.

Domain Name NIS or NIS+ domain for this workstation.
Note: This window is not displayed if the workstation is
not using the NIS or NIS+ service.
Chapter 2 Setting Up the Preinstalled Solaris Operating Environment Software 11



4. When you reach the setup window titled End, click the Confirm button.

The workstation displays the login window, in which you can enter your user name
and password to log in and begin using the workstation.

Tip – A number of other useful software packages have also been preinstalled on
your workstation. For information on those applications, see “Getting Started With
the Additional Preinstalled Software” on page 17.

5. Review the Solaris release notes for any late-breaking information about your
preinstalled software.

The Solaris 8 HW 2/04 Release Notes and the Solaris 9 4/04 Release Notes can be found
at:
http://docs.sun.com

Sun Install Check
The Sun Install Check tool verifies and provides information about workstation
software and hardware configuration. Before you can run the Sun Install Check tool,
you need to download it from the following web site:

Name Server/
Subnet/
Subnet Mask

Name server (specify the server or have the workstation
find one on a local subnet).
Note: This window is not displayed if the workstation is
not connected to a network.
Note: Depending on how you answer and what
information is provided by your network, you might also
be prompted for:
- The subnet for the workstation
- The subnet mask for the workstation

Time Zone Local time zone (select by geographic region, GMT offset,
or a time zone file).

Date and Time Current date and time (accept the default or enter the
current date and time).

Root Password Root (superuser) password for the workstation.

Proxy Server
Configuration

Workstation connection: direct to the Internet or through a
proxy server.

TABLE 2-1 Information for Setting Up the Solaris Desktop Operating Environment (Continued)

Setup Window Explanation and Notes Your Information
12 Sun Blade 1500 Getting Started Guide • April 2004
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http://wwws.sun.com/software/installcheck/index.html

For more information, see Chapter 5 of the Sun Blade 1500 Service, Diagnostics, and
Troubleshooting Manual, 816-7564.

Sun Blade 1500 Software Enhancement
Script
To ensure that your system software has the latest improvements, install and run the
software enhancement script. The script is available at the following web site:

http://sunsolve.sun.com/handbook_pub/Systems/SunBlade1500/SunBla
de1500.html

To download the software enhancement script, select the link: Sun Blade 1500
Software Enhancement Script

For instructions on using the software enhancement script, see Chapter 5 of the Sun
Blade 1500 Service, Diagnostics, and Troubleshooting Manual, 816-7564.

Power Management Features

Sun Microsystems is an ENERGY STAR® partner. Those configurations of this
product that bear the ENERGY STAR mark, meet or exceed the ENERGY STAR
guidelines. For information about which configurations are Energy Star compliant,
select the Sun Blade 1500 link on the http://www.sun.com/ web site.

The Power Management™ software that is integrated with your Solaris operating
environment improves the energy efficiency of your workstation. Internal
subsystems enter a low-power mode after a specified period of inactivity (the
default period is 30 minutes). Power is returned to subsystems on an as-needed
basis.
Chapter 2 Setting Up the Preinstalled Solaris Operating Environment Software 13
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While in low-power mode, your workstation retains network-awareness, such that it
responds to tasks directed to it. Subsystems then again enter low-power mode after
the specified period of inactivity. For details and information on how to change the
power management settings on your workstation, refer to the “Solaris User
Collection” document, Using Power Management (see “Solaris Documentation” on
page 18).

The power-indicator LED in the center of the front panel Power button has three
states that indicate the power status of the workstation, as described in TABLE 2-2.

Putting the Workstation Into Low-Power Mode
After a predetermined period of inactivity, the workstation might automatically
enter the low-power mode. You can manually put the workstation into low-power
mode.

1. Press the Sun Type 6 USB keyboard Sleep key (FIGURE 2-2).

The Power Off Selection dialog box is displayed.

2. Select LowPower from the Power Off Selection dialog box.

The workstation completes any in-process activities, then enters low-power mode
after a short time-out period.

Note – Use the keyboard Sleep key to place the workstation in low-power mode or
to power off the workstation. See FIGURE 2-2.

Note – The Sleep key cannot be used to power on the workstation. Press the Power
button on the front panel to power on the workstation.

TABLE 2-2 Power-Indicator LED Status

LED Activity Meaning

LED off System power is off or the workstation is booting up.

LED blinking All internal subsystems are in the lowest possible power
consumption mode for this workstation.

Note: Some hardware components and software drivers do not
support the workstation’s lowest possible power consumption
mode. When this occurs, the power indicator LED does not blink.

LED on Full power is on in one or more of the internal subsystems and the
system self-test has completed successfully.
14 Sun Blade 1500 Getting Started Guide • April 2004



FIGURE 2-2 Sun USB Type-6 Keyboard Sleep Key and Power Off Selection Menu

Activating the Workstation From Low-Power
Mode
To activate a workstation that is in low-power mode, move the mouse or press any
key on your keyboard. The monitor display, if blank, refreshes and the CPU and
hard drives return to full power as needed.

Note – By default, the internal disks of the hard drive are stopped when the
workstation is in low-power mode. The internal disk drive can take as long as 30
seconds to restart and reach the correct speed. To change hard drive power
management settings, refer to the preinstalled “Solaris User Collection” document,
Using Power Management (see “Solaris Documentation” on page 18).
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CHAPTER 3

Getting Started With the Additional
Preinstalled Software

This chapter includes information about the following topics:

Desktop System Software and Related Documents

� Solaris Documentation
� Sun Blade 1500 Hardware Documentation
� Mozilla
� Solstice DiskSuite and Volume Manager
� Common Desktop Environment (CDE)
� GNOME Desktop Environment
� Apache Server
� Restoring Preinstalled Software
� Backing Up the Preinstalled Image to Another Hard Drive

Collaboration and Interoperability Software
� Adobe Acrobat Reader

Productivity Software

� Sun ONE Grid Engine
� StarOffice

Developer Tools

� Sun ONE Studio
� Perl
� Development Tools for the Java Platform

Multimedia Software

� JMStudio
� SunForum
17



Restoring Preinstalled Software and Backing Up the Preinstalled Image
� Restoring Preinstalled Software
� Backing Up the Preinstalled Image to Another Hard Drive

Solaris Documentation

For Solaris™ operating environment documentation, refer to the following web site:

http://docs.sun.com

For Solaris on Sun Hardware documentation, refer to the following web site:

http://www.sun.com/documentation/

Select the links:

Hardware Product Categories→Software→Solaris on Sun Hardware

Sun Blade 1500 Hardware
Documentation

Documentation on the Hard Drive
The Sun Blade 1500 Service, Diagnostics, and Troubleshooting Manual, with linked
multimedia service procedures, is installed on the hard drive in PDF format.

To view the service manual in PDF format, type the following at the command line:

/opt/SunBlade1500_Service_Manual/PDF/816-7564.pdf
18 Sun Blade 1500 Getting Started Guide • April 2004

http://www.sun.com/documentation/
http://docs.sun.com


Note – To view the documents, you might first need to install Adobe Acrobat
reader. See “Getting Started With Adobe Acrobat Reader” on page 22.

Documentation on CD
Documentation for the Sun Blade 1500 is included on the Sun Blade 1500 Hardware
Documentation CD that shipped with your system. The document, How to Use This
CD (817-0584), contains a list of CD contents as well as instructions for using the Sun
Blade 1500 Hardware Documentation CD (705-1078).

Note – ShowMe™ How video animations are located on the Sun Blade 1500
Hardware Documentation CD (705-1078). These video animations demonstrate
installation and removal procedures for DIMMs, PCI cards, hard drives, and DVD-
ROM drives.

Mozilla
Mozilla is the world’s premiere open source browser for the Internet. For more
information about Mozilla, refer to the following web site:

http://www.mozilla.org/

Getting Started With Mozilla
To start Mozilla in a terminal window type:

/usr/dt/bin/mozilla
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Solstice DiskSuite and Volume Manager
Solstice DiskSuite™ and Volume Manager are disk and storage management
applications for the Solaris operating environment that enable high data availability,
improved data reliability, enhanced system and I/O performance, and simple large
system and disk administration.

Getting Started With Solstice DiskSuite on
Solaris 8
To start Solstice DiskSuite type: /usr/sbin/metatool

For additional information on starting Solstice DiskSuite, see the Solstice DiskSuite
User’s Guide at:

http://www.sun.com/documentation/

Select the links:

Hardware Product Categories→Software→Solaris on Sun Hardware

Getting Started With Volume Manager on
Solaris 9
For additional information on starting Solaris Volume Manager, see the Solaris
Volume Manager Administration Guide at:

http://docs.sun.com
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Common Desktop Environment (CDE)
CDE is the default desktop environment for both Solaris 8 and Solaris 9 operating
environments on the Sun Blade 1500 workstation.

Find more information about CDE within the Solaris User ’s Collections at:

http://www.sun.com/documentation/

� Solaris Operating Environment→Solaris 8→Solaris 8 User Collection
� Solaris Operating Environment→Solaris 9→Solaris 9 User Collection

GNOME Desktop Environment
GNOME is a freely distributable desktop environment that provides a graphical user
interface. For more information on GNOME, go to this web site:

http://www.gnome.org/

Getting Started With GNOME
The default desktop environment for the Sun Blade 1500 workstation is CDE. Follow
the instructions below to use GNOME.

1. Log out of your CDE session.

2. At the login window, select the Options menu.

3. Select the Sessions submenu.

4. Select GNOME from the menu.

5. Log in to your system.
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Apache Server
Apache Server is an open-source web server. Apache Server is a secure, efficient, and
expandable server that provides services that comply with the current HTTP
standards.

Getting Started With Apache Server
To activate the web server on your workstation, follow the steps below:

1. Become superuser (root) by typing su and your superuser password.

2. Copy the example configuration file httpd.conf-example to httpd.conf by
typing the following:

cp /etc/apache/httpd.conf-example /etc/apache/httpd.conf

3. Edit the configuration file to customize it for your workstation.
For example, you should set the HTML directory for your workstation.

For more information, refer to the online Apache User’s Guide by clicking the
Documentation link on the following web site:

http://www.apache.org/httpd.html

4. Start the web server daemon by typing the following:

/etc/rc3.d/S50apache start

Adobe Acrobat Reader
Adobe Acrobat Reader is a free and freely distributable software program that
allows you to view and print Portable Document Format (PDF) files. PDF is a file
type that allows you to view and print a file exactly as the author designed it. You
do not need the original application or fonts that the author used to create the file.

Getting Started With Adobe Acrobat Reader
To install Adobe Acrobat Reader, type:
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/opt/spool/acroread/INSTALL

To start Adobe Acrobat Reader after installation, type:

/path/bin/acroread

Where path is the directory where you installed Adobe Acrobat Reader.

(The default installation path is /opt/Acrobat5.)

Sun ONE Grid Engine
Sun ONE Grid Engine is preinstalled on your hard drive. Before setting up Sun ONE
Grid Engine, you should read the Sun ONE Grid Engine documents at the following
web site:

http://www.sun.com/products-n-solutions/hardware/docs/Software/
S1GEEE/index.html

For more information refer to the following web site:

http://wwws.sun.com/software/gridware/ds-gridware/index.html

StarOffice
StarOffice™ is the optimum in office productivity software from Sun Microsystems.
StarOffice is a powerful and comprehensive office suite that integrates word
processing, spreadsheets, graphics, HTML, and database components into a single
workspace.

Key features include:

� Robust and scalable integrated office productivity tools that include word
processing, spreadsheets, graphics, web publishing, and database applications.

� A cross-platform, open-world approach—StarOffice runs natively on Solaris
software (SPARC® and Intel processors), Microsoft Windows NT, Windows 98,
Windows ME, Windows 2000, and Linux.

� Interoperability with Microsoft Office files, allowing seamless and transparent
migration and exchange of word processing, spreadsheet, and presentation files.

� A fully integrated work environment that utilizes a single workspace, enabling
easy access, management, editing, and sharing of information.
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� Built-in web publishing that enables easy HTML web page creation, design, and
publishing.

Product components:

� StarOffice Writer—a universal word processing application for creating business
letters, extensive text documents, professional layouts, and HTML creation

� StarOffice Calc—a sophisticated application for performing advanced spreadsheet
functions, such as analyzing figures, creating lists, and viewing data

� StarOffice Impress—a tool for creating effective, eye-catching presentations

� StarOffice Draw—a vector-oriented drawing module for creating 3D illustrations

� StarOffice Base—a powerful data management tool that enables data to be moved
between documents

Getting Started With StarOffice
To start the preinstalled StarOffice software, click the StarOffice icon on the CDE
desktop task bar.

To start StarOffice, type:

/opt/staroffice7/language/program/soffice

Where language is english, french, german, italian, japanese,
korean, spanish, swedish, simplified_chinese, or
traditional_chinese.

For details about using StarOffice software, refer to the application’s built-in help
system.

Note – Support for StarOffice is not included with your Sun Blade 1500 workstation.
StarOffice software support services must be contracted separately. For the latest
information on StarOffice support services, see the following web sites:
http://wwws.sun.com/software/star/staroffice/index.html
http://wwws.sun.com/software/star/starsuite/
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Sun ONE Studio
Sun ONE Studio, Community Edition is an Integrated Development Environment
(IDE) for Java™ technology developers. Based on the NetBeans™ Tools Platform,
Sun ONE Studio software provides the latest support for Java and industry
standards in the development of enterprise class applications and web services.

Getting Started With Sun ONE Studio
To install Sun ONE Studio, type:

/opt/spool/sun-one-studio/ffj_ce_solsparc.bin

For more information, refer to the following web site:

http://www.sun.com/software/sundev/jde/index.html

Perl
Perl is a programming (scripting) language available as open-source software. Perl’s
process, file, and text manipulation facilities make it particularly well-suited for
tasks involving quick prototyping, workstation utilities, or software tools.

Getting Started With Perl
To start Perl, type:

/usr/bin/perl

For information about using Perl, refer to the man pages for the application by
typing:

man perl
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Development Tools for the Java Platform

The following Sun development tools for the Java platform are preinstalled on your
workstation.

Note – If you need to restore the Java products, you can download the latest
versions by selecting links from the following web site:
http://java.sun.com/products/

� Java 2 Runtime Environment and Software Development Kit is installed at
/usr/java/. For more information, refer to the following web site:

http://java.sun.com/products/j2se/

� Java 3D™ API is available in the Java 2 SDK. For more information, refer to the
documentation links from the following web site:

http://java.sun.com/products/java-media/3D/

� Java Plug-In is a plug-in for the Netscape browser that provides complete support
for the standard Java runtime software. For more information, refer to the
following web site:

http://java.sun.com/products/plugin/

� Java Media Framework is installed at /opt/JMF. For more information, refer to
the following web site:

http://java.sun.com/products/java-media/jmf/

To install the Java Media Framework, type:
cd /opt ; /opt/spool/jmf/install

� The Java Communications API can be used to write platform-independent
communications applications for technologies such as voice mail, fax, and smart
cards. For more information, refer to the following web site:

http://java.sun.com/products/javacomm/
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JMStudio
JMStudio is a stand-alone Java application that uses the JMF 2.0 API to play, capture,
transcode, and write media data. JMStudio also uses the JMF RTP APIs to receive
and transmit media streams across the network.

JMStudio is included with the Java Media Framework, a development package. (See
“Development Tools for the Java Platform” on page 26.)

For more information on Java Media Framework, refer to the following web site:

For more information on JMStudio, refer to the following web site:

http://java.sun.com/products/java-media/jmf/2.1.1/jmstudio/
jmstudio.html

Getting Started With JMStudio
To use JMStudio, you must first install Java Media Framework. (See “Development
Tools for the Java Platform” on page 26.)

To start JMStudio, type: /opt/JMF2.1.1/bin/jmstudio

Note – ShowMe How video animations are located on the Sun Blade 1500 Hardware
Documentation CD (705-1078). These video animations demonstrate installation and
removal procedures for DIMMs, PCI cards, hard drives, and DVD-ROM drives. You
can use JMStudio to play these animations.

SunForum
SunForum™ enables you to collaborate with colleagues while working in a
heterogeneous environment of Sun workstations, PCs, and Apple computers. Using
SunForum, you can choose to interact through any of the following industry
standard H.323 features over your TCP/IP network:

� Video and audio conferencing between two or more people.

� Shared native and non-native applications that enable PC applications to run on a
Solaris desktop, and vice-versa, providing the ability to transfer control of the
applications between participants.
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� A shared whiteboard, chat window, clipboard, or file.

Getting Started With SunForum
To start SunForum, type: /opt/SUNWdat/bin/sunforum

For more information about SunForum, or to download the latest version, refer to
the following web site:

http://www.sun.com/desktop/products/software/sunforum/

Restoring Preinstalled Software
Your workstation comes preconfigured with the Solaris operating environment and
other preinstalled software. However, if you replace your hard drive for any reason,
the replacement drive does not come preconfigured with the Solaris operating
environment or the other preinstalled software.

You should make and keep a full backup of the operating environment, which can
be used to restore your system if it is ever needed. Instructions for backing up your
operating environment are included in the preinstalled Solaris System Administration
Guide.

You can also restore some of the software that is preinstalled on your disk from the
CD-ROMs included in the appropriate version of the Solaris Media Kit. The Solaris
Media Kit contains some of the same software that is preinstalled on your
workstation. To reinstall some software, you may need to download the software
from the web sites provided throughout this document. Some software product
companies, such as Netscape, offer different versions of software on their respective
web sites.

Restoring the Solaris Preinstalled Software

Note – You must use Solaris 8 HW 2/04 or Solaris 9 4/04 or subsequent compatible
versions on the Sun Blade 1500 workstation.
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1. Get the backup media, the Solaris Media Kit.

You might already have the Solaris Media Kit if you ordered it with your
workstation. If you did not order the kit with your system, contact your Sun sales
representative and ask to order the Solaris Media Kit for your language and Solaris
version. For more information, refer to the following web site:

http://wwws.sun.com/software/solaris/binaries/get.html

2. Follow the installation instructions in the Start Here document that comes with
the kit.

You can install the Solaris operating environment and as much of the additional
software as you want.

More patch information is available at this web site. You can also download patches
from this web site:

http://sunsolve.sun.com/

The Sun Blade 1500 Product Notes might also contain patch and software version
information. To obtain the latest Sun Blade 1500 Product Notes, refer to the following
web site:

http://www.sun.com/documentation/

Select the links: Additional Hardware Documentation→Desktop & Workstation→

Sun Blade Workstations→Sun Blade 1500.

Restoring the Sun Blade 1500 Documentation
� To restore the workstation hardware documentation, reinstall it from the Sun Blade

1500 Hardware Documentation CD (705-1078) that is included with your workstation.

Use the instructions in the document, How to Use This CD (817-0584).

Reinstalling Other Software
If you must reinstall other software packages, be sure that you have the latest
software version. For more information on the latest software versions, refer to the
web sites listed throughout this guide.

Reinstalling StarOffice Software
You can download the Community Edition of StarOffice for free from:
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http://Openoffice.org/

To obtain the full-featured StarOffice product, contact your StarOffice business
development representative or authorized Sun sales agent to order the Enterprise
Edition of StarOffice.

You can also order the latest version of a full product media kit that includes user
documentation and the software on CD-ROM from the following web sites:

http://wwws.sun.com/software/star/staroffice/get/index.html

http://wwws.sun.com/software/star/starsuite/get/index.html

Reinstalling Mozilla
For more information on reinstalling Mozilla, refer to the following web site:

http://wwws.sun.com/software/download/

Select the link:

Top 10 Software Downloads

Backing Up the Preinstalled Image to
Another Hard Drive
Information about hard drive backups can be found in the Solaris System
Administration Guide. To obtain this guide, refer to the following web site:

http://docs.sun.com

Select the links:

� All Solaris Versions→Solaris 8→Solaris 8 System Administrator Collection
� Solaris 9→System Administrator Collection
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Hard Drive Mirroring

Solaris 8

Refer to the Solstice DiskSuite User’s Guide for your Solaris version. The guide
describes many different methods for managing hard drives.

For additional information on Solstice DiskSuite, see the Solstice DiskSuite User’s
Guide at:

http://www.sun.com/documentation/

Select the links:

Solaris Operating Environment→Software→Storage

Solaris 9

For additional information on starting Solaris Volume Manager, see the Solaris
Volume Manager Administration Guide at:

http://www.sun.com/documentation/

Select the links:

Solaris Operating Environment→Solaris 9 4/04→Solaris 9 4/04 System Administrator
Collection→Solaris Volume Manager Administration Guide
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CHAPTER 4

Troubleshooting and Technical
Support

This chapter contains information to help you troubleshoot minor workstation
problems.

This chapter includes information about the following topics:

� Troubleshooting the Sun Blade 1500 Workstation

� How to Get Technical Assistance

Troubleshooting the Sun Blade 1500
Workstation
If you experience problems while setting up your workstation, refer to the
troubleshooting information in TABLE 4-1.

TABLE 4-1 Troubleshooting Procedures

Symptom Troubleshooting

Workstation powers on,
but the monitor does
not.

1. Is the Power button for the monitor turned on?
2. Is the monitor power cord connected to a wall outlet?
3. Does the wall outlet have power? Test by plugging in another device.

System stops booting
after the ok prompt is
displayed.

At the ok prompt type: boot
If the system does not boot, contact your system administrator or a Sun Service
Support Center.
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CD or DVD does not
eject from the media
tray when you press
the Eject button.

User-Level Procedures

1. Move the mouse or press any key on the keyboard. The drive might be in low-power
mode.

2. Attempt to eject the CD using the Eject button on the media drive.
3. In a terminal window type: eject cdrom

4. If Step 3 does not work, verify that the CD is not mounted. In a terminal window,
type: df | grep cdrom

If the CD is mounted, text similar to this example will be displayed:
/cdrom/wzi-2230 (/vol/dev/dsk/c0t2d0/wzi-2230): 0 blocks 0 files

5. Unmount the CD by typing: umount and the command output shown in parentheses
above. In the example above, the mount point is wzi-2230 and you would type:
umount /vol/dev/dsk/c0t2d0/wzi-2230

6. Type the command: eject cdrom

Alternate Procedure for Media CDs

1. Right-click the mouse and select Workspace Menu→Folders→Open CDROM.
A File Manager window should open.
2. Select File→Eject.
3. If the CD does not eject, use a terminal window to exit the CD directory by typing:
cd

4. Try again to eject the CD from the File Manager window.
If you need further assistance, contact your system administrator or a Sun Service
Support Center.

System Administrator Emergency Procedures for All CDs

As superuser, stop the vold daemon:
1. Open a terminal window.
2. As superuser, type: /etc/init.d/volmgt stop

3. Press the Eject button on the media player.

Note: To mount another CD, you need to start vold by typing:
/etc/init.d/volmgt start

If the CD has not ejected using Step 3 above, complete these steps:
1. Bring the system to the ok prompt.
2. Press the Eject button.
If the CD still does not eject using the two processes above, there might be a cable
problem or other hardware problem. Call a Sun Service Support Center for further
assistance.

TABLE 4-1 Troubleshooting Procedures (Continued)

Symptom Troubleshooting
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No video displays on
the monitor screen.

1. Is the monitor cable attached to the graphics accelerator?
2. Does the monitor work when connected to another system?
3. If you have another monitor, does it work when connected to the original system?
4. Verify that OpenBoot™ PROM defaults are set properly:
• Press and hold the Power button for 4 seconds to power off the system.
• Wait 4 seconds and power on the system.
• As soon as the Power button blinks, quickly press the Power button twice. The ok

prompt is displayed and the system enters a safe NVRAM mode.
• Verify these OpenBoot PROM parameters: output-device is set to screen and
input-device is set to keyboard.

• If the ok prompt does not display, or if changing the output-device setting does
not help, contact a Sun Service Support Center.

Workstation does not
power on when the
front panel Power
button is pressed.

Keep notes on the following situations in case you need to call service:
1. Is the Power button LED illuminated on the front of the system?
(Ensure that the power cord is connected to the system and to a grounded power
receptacle.)
2. Does the wall outlet have power? Test by plugging in another device.
3. Does the system beep when the system is powered on? (Ensure that the keyboard is

plugged in.)
4. Test with another keyboard that you know is functional. Does the system beep when

you connect the keyboard and power on the system?
5. Does the monitor sync within 5 minutes after power on? (The green LED on the

monitor stops flashing and remains illuminated.)
Note: If the monitor syncs but does not display an ok prompt or a login window, the
system might not be passing POST. Call a Sun Service Support Center.
If the system passes POST and displays the ok prompt but does not boot Solaris,
type: boot

Keyboard or mouse
does not respond to
actions.

1. Verify that the mouse and keyboard cables are connected to the on-board USB 1.1
connectors on the workstation. (Do not connect the mouse and keyboard to the USB
connectors on the IEEE 1394 and USB 2.x card.)

2. Verify that the workstation is powered on and the front Power button LED is
illuminated.

Workstation appears to
be in low-power mode,
but the Power button
LED does not blink.

The power-indicator LED only blinks when all workstation components are in low-
power mode. A tape drive might be connected to your workstation. Because tape
drives do not enter low-power mode, the power-indicator LED does not blink.

TABLE 4-1 Troubleshooting Procedures (Continued)

Symptom Troubleshooting
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Hung application.
Application won’t
respond.

Procedure 1: Using the Host Workstation

1. From the CDE toolbar, select Tools→Process.
2. In the Process Manager window, select Find Process.
3. Select the process that is hung. The name of the application or process is in the

Command column.
4. From the Process Manager menu, select Process→Kill Process.
Note: You may be able to log in from another workstation and use these same GUI
tools to save and close, or kill applications.

Procedure 2: Using a Terminal Window From Your Own Workstation

1. To determine the ID number of the hung process, type: ps -ef | grep process
name

Note: First kill the last application you used when the system hung and, if necessary,
kill the next most recent applications that you used.
2. To stop the process, type: kill -9 process ID

Procedure 3: Using Remote Login or Telnet

1. From another workstation, use a terminal window and type either:
rlogin hostname
or type: telnet hostname
2. Type your login ID and password.
3. From the terminal window, type: ps -ef | grep process name
4. Start killing processes. Type the name of the last application you were using when

the system froze.
Type: kill -9 process ID
After killing the processes for the last-used application, look at your system to see if it
is usable. If not, continue to kill processes until the system is usable or until you can
shut it down and restart it.
CAUTION: Be sure to log off from the remote system. Another user might be able to
access your system if you do not exit the terminal window.
5. On the second workstation, type exit and close the terminal window.

TABLE 4-1 Troubleshooting Procedures (Continued)

Symptom Troubleshooting
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During the boot
procedure, the system
displays a network
error message.

Use this procedure if the system displays these error messages:
Warning: timed out waiting for NIS to come up

:Timeout waiting for ARP/RARP packet

1. From a remote system, ping the system with this command: ping hostname
2. Verify with your system administrator that the network is operational.
3. Is the Ethernet cable connected between the workstation and the wall outlet or

router?
4. Try connecting another Ethernet cable. Does the new cable work?
5. If cable changes do not help, bring the system to the ok prompt and verify the

OpenBoot PROM settings. Most systems should be set to diag-switch? = false
and boot-device set to disk net. For more information on OpenBoot PROM
settings, see the Sun Blade 1500 Service, Diagnostics, and Troubleshooting Manual, 816-
7564, or contact a Sun Service Support Center.

Hung or frozen
workstation: No
response from mouse
or keyboard or any
application.

1. Try to access your system from a different workstation on the network.
2. From a terminal window type: ping hostname
3. If no response, remotely log in from another system using telnet or rlogin, and

ping the system again.
4. Attempt to kill processes until the system responds. (See the procedures for “Hung

Application” in this table.)

If the above procedures do not work:

Caution: Only experienced system administrators should use a “Stop” command.
Using any “Stop” command might cause loss of core dumps, which makes it difficult
to diagnose system problems.
1. Press Stop-A. If the system responds, the system displays the ok prompt.
2. Try to force a core file dump. At the ok prompt, type this command: sync
Note: The default location for a core file deposit is: /var/crash/hostname
3. The Sun Service Support Center might request the core file for root cause analysis.

If the above procedures do not work:

1. Press the Power button to power off the system.
2. Wait 20 to 30 seconds and power on the system.
Note: When you power on the system again, you might need to run fsck to repair
damaged links. If the system still does not function properly, contact Sun Service
Support.

For more troubleshooting information see the Sun Blade 1500 Service, Diagnostics, and Troubleshooting
Manual (816-7564).

TABLE 4-1 Troubleshooting Procedures (Continued)

Symptom Troubleshooting
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TABLE 4-2 Sun Web Sites and Telephone Numbers

Sun Blade 1500 Workstation Documents and Support Resources URL or Telephone Number

PDF files for all the current Sun Blade 1500 Documents. Key documents
include:
Sun Blade 1500 Service, Diagnostics, and Troubleshooting Manual, 816-7564
Sun Blade 1500 Getting Started Guide, 816-7565
Sun Blade 1500 Product Notes, 816-7569

http://www.sun.com/documentation/

Select the links:
Desktops & Workstations→Sun Blade
Workstations.
Select the Sun Blade 1500 link.

Find Solaris and other software documents here. This is also an
alternative web site for some Sun Blade 1500 workstation documents.
This web site has full search capabilities.

http://docs.sun.com/

Find Solaris on Sun Hardware documentation here. http://www.sun.com/documentation/

Select the links:
Hardware Product
Categories→Software→Solaris on Sun
Hardware.

Warranty and Contract Support contacts. Links to other service tools. http://www.sun.com/service/online/

Discussion and Troubleshooting Forums. http://supportforum.sun.com/

Support, Diagnostic Tools, Alerts, for all Sun products. http://www.sun.com/bigadmin/

SunSolve™: Contains links to software patches. Lists some system
specifications, troubleshooting and maintenance information, and other
tools.

http://www.sunsolve.sun.com/handbook
_pub/

Warranties for every Sun product. http://www.sun.com/service/support/w
arranty/

Sun Service Support Phone Numbers. 1-800-872-4786 (1-800-USA-4Sun) Select Option 1

This web site lists international telephone numbers for Sun Service
Support.

http://www.sun.com/service/contactin
g/solution.html
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